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Introduction
Internet Kiosk software converts computer into self-service kiosk. It prevents hacking and downtime,
blocks the system keys like Ctrl-Alt-Del, restricts access to the system, desktop, drives, folders and
programs. You can use it to securely display your website or application, show marketing messages and
advertisements, bill for Internet use, games or office applications, sell tickets for WiFi HotSpot around
your kiosk, and much more. We can build any application for you, and integrate in the Kiosk's secure
environment.

Creating YOUR kiosk is easy. You need a PC and our Kiosk
software. Antamedia Kiosk software works on any Windows
and any hardware. It’s touch-screen compatible and runs
even on low-spec computers.

1.1

Installing Kiosk
To install Antamedia Kiosk software, please download installer from http://www.antamedia.com/
download/kiosk
Run installer, agree to EULA, and click the NEXT button. On the next screen, you will be able to choose
between Express and Custom installation. Express installation will install Kiosk software, Pay Station
software and Database Server software at default paths (C:\Antamedia\Kiosk, C:\Antamedia\Pay Station,
C:\Antamedia\DBServer). Custom installation offers the choice which software modules to install, and to
change the installation path of the selected software.
During installation, files will be stored on the hard drive, installer will create a limited windows account,
and turn your computer into a secure self-service Kiosk. To successfully complete installation of selected
software press "Run" button (if you use Windows XP), or button "Reboot" (if you use Vista/Windows7).
IMPORTANT
If you use Windows XP after you press button "Run" Antamedia Kiosk software will launch and you can
select and configure Kiosk mode that best fits your needs.
If you use Windows Vista, Windows 7, Windows 8.1 or Windows 10, after you press "Reboot" button, the
computer will reboot and it is necessary to log in administrator account. After logging in to the
administrator account Kiosk software will run and you can select and configure Kiosk mode that best fits
your needs.
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1.2

Kiosk Modes
Antamedia Kiosk software includes many modes suitable for different deployment. From the main screen,
please choose a type of Kiosk you would like to create. Depending on your choice, you will get options for
securing and customizing your Kiosk.
Kiosk Free

Kiosk Paid

Kiosk Free mode helps you convert your
computer into secure workstation. Your
customers can browse the pages free of
charge for limited or unlimited time, you
can require entering a shared keyword, or
you can require customer signup before
the free session starts.

Kiosk Paid mode helps you bill for Kiosk
usage. Kiosk can be configured to allow
access after the customer inserts the money
in the coin or bill acceptor, or to accept only
those customers who already obtained a
ticket with access code or the username
and the password.

All-In-One

Protected Windows

Pay Station with Kiosk is a combination of
payment acceptor and secure Kiosk
environment. One Kiosk can be used for
both receiving payments and issuing tickets
(for WiFi also when used with HotSpot)
and for serving applications or websites
to your customers.

Protect your Windows with Kiosk's security
options. You can limit access to selected
drives, programs, limit browsing to illegal
websites, offer selected programs using
customized Start Menu and combine other
Windows features for your users.
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Digital Signage

Pay Station

Digital Signage transforms your Kiosk into
digital multimedia display. It shows media
content, advertisements or information in a
desired layout. If you run a Kiosk with dual
display, you can show Digital Signage
screen on a secondary monitor and leave
primary monitor for the main activity.

Pay Station helps you collect coin, bill and
credit card payments from your customers.
After the successful payment, customer
receives a ticket which can be used to login
into kiosk. Any remaining time can be used
on the next customer login until it expires.
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1.3

Kiosk Solutions
Check-in & Reservation
Minimize staffing requirements and automate common tasks with applications. Popular uses are for
airport and hotel check-in, concerts and fitness clubs, hospitality and sports events. Self-service
reservations are popular for restaurant tables, golf course, spa centers where customer privacy matters.
In-Store Product Information
Provide accurate product information, product ordering and guided selling to increase sales revenue.
Show product comparison, how-to, and help customer easily find the product in your store. Accurate
product information reduce returns and increases chance for additional accessory orders.
Internet Kiosk
Internet kiosks offer high speed Internet access, Email sending, Office software, PC and online gaming,
entertainment features. Antamedia Kiosk software helps you easily implement free or pay for use kiosks,
and configure applications available for customer use.
WiFi HotSpot Kiosk
Expand service around your kiosk by installing Antamedia HotSpot and an access point. WiFi devices such
as tablets, laptops, smart phones can utilize your services free or for a fee. Bill for Internet use by the
time, data transfer and offer different price plans for returning customers.
Pay Station
Self-service ticket dispenser helps you automate selling of the prepaid Internet tickets. It runs as a
standalone service, or as an integrated part of the Kiosk. It collects bill, coin, credit card and PayPal
customer payments and creates tickets which can be used on all kiosks or hotspots in your network.
Digital Signage
Engages customers and arouses interest in your products and services. Show retail advertizing,
consumer information, travel and weather updates by combining videos, images, web pages, flash
animations. Unlike print materials, changes can be made in a minute with no additional cost.
Loyalty programs
Help customer check their points or account balance. Show targeted per-customer special offers on kiosk.
Implement NFC contactless smart cards that can be used as a payment device, loyalty card or entrance
card. Antamedia Kiosk software and loyalty solution can fit into your project.
Queuing & Guidance
Manage a large number of customers with a small number of service representatives. Integrate with your
database to provide representative availability, remote VoIP communication, and guidance. Deployments
range from customer service, waiting rooms, government services to business incubators.
Custom Development
We can assist you or develop an entirely new theme for your business, interface your application with the
Kiosk, integrate with your Hotel, Resort, Airline, Hospitality PMS system, or develop new software that will
run on top of the secure Kiosk shell. Please contact us for more details.
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2

Browser

2.1

Secure Browser
Antamedia Secure Browser appearance and general options can be configured from Kiosk - Browser Design page. From dropdown menu on the left side of the page you can select one of the 6 predefined
Secure Browser skins. You can configure Kiosk to use Internet Explorer as its browser by checking
"Replace Antamedia Secure Browser with Internet Explorer" option. Explanation of the other options on
this page:
Limit the number of open pages
in the Secure Browser

Use this option to limit maximum number of opened tabs

Show keyboard button for
a virtual keyboard

Hide/Unhide virtual keyboard button from browser’s top bar

Show QWERTY keyboard

Enables virtual keyboard part that contains letters

Show Numeric keypad

Enables virtual keyboard part that contains number keypad

Show Close button

Hide/Unhide close button from the browser’s top bar

Show Minimize button

Hide/Unhide minimize button from the browser’s top bar

Show Restore button

Hide/Unhide restore button from the browser’s top bar
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Show button Reset Browser

Hide/Unhide reset browser button from the browser’s top bar.
This button closes current instance of Secure Browser and
opens a new one. All browser history, cookies and cache are
deleted during this process.

Reset all opened browsers to
home page after

Use this option to force Secure Browser to reset itself to
homepage after specified time period bar

Show animation on browser
background

This option toggles animation in the Secure Browser’s
navigation bar

Show Search box

Hide/Unhide web search box from the browser’s navigation
bar

Show Address bar

Hide/Unhide URL address bar from the browser’s navigation
bar

Full Screen - Hide browser
navigation and toolbars

Use this option to enable full screen mode for Secure Browser

Show Secure Browser Dialog
Boxes (Open, Print, Find...)

Check this option to enable showing dialog boxes in Secure
Browser

Show Secure Browser in the
taskbar

Hide/Unhide Secure Browser from the Kiosk taskbar

Disable minimize Secure Browser

This option is available if Secure Browser is shown in taskbar,
it disables minimizing browser by clicking its entry in taskbar
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2.2

Start Page
Kiosk software can be configured to use Internet Explorer or Antamedia Secure Browser. If Antamedia
Secure Browser is used, its start page is determined by the Kiosk operation mode (Free, Paid, Digital
Signage etc.), with the exception of Free Anonymous access mode. Further options for this mode can be
configured on Kiosk - Browser - Start page screen. There are 3 options available for Antamedia Secure
Browser start page:
Kiosk start page templates - You can choose from several editable templates
User defined start page - You can use any website URL as a start page
Limit browsing to a set of websites - This option can be used to prevent Kiosk users from visiting
websites outside of the predefined set of allowed pages. To add new website, click on “New” button and
type URL of desired website. All websites in the list with “Auto Open” option checked will be opened
automatically after starting Antamedia Secure Browser. Websites with “Show Close” option checked will
have closing button on their tab

Changing Logo
To replace default logo on the page with the logo of your company, please follow these steps:
1. In the Antamedia Kiosk go to "Browser" and choose "Start Page"
2. Choose Secure Browser start page (Kiosk Free, Kiosk Paid etc)
3. Press "Change logo image" button and select picture for a new logo.
To Show Welcome Message on Session Start select option and Type welcome message. After you
configure desired options, please click “Save” button.
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2.3

Security Options
Antamedia Secure Browser uses Internet Explorer as a core, and builds secure browsing environment
with additional features. Variety of features that you can configure may increase or decrease security
level, which mostly depends on the type of application or website that will execute in the Secure Browser.
We recommend testing your application or website and adjusting available features until you achieve
optimum performance and security.
These features can be configured from Kiosk - Browser - IE Security and Kiosk - Browser - Browser
Security pages. Some of the settings on these pages apply to Internet Explorer as well as Antamedia
Secure Browser.
Explanation of settings on IE Security page:
Security Internet Zone (Applies to Internet Explorer and Antamedia Secure Browser)
Allow Java

This setting determines if Java Runtime Environment can be used in the
browser.

Allow download signed
ActiveX controls

This option allows users to download signed ActiveX controls from
pages.

Allow installation of
desktop items

This setting determines if users can install Active Desktop items.

Allow Java applets

An applet is a small Internet-based program written in Java, usually
embedded in a web page and can be executed from within a browser.
This option determines whether Java applets will be allowed.

Allow download unsigned This option allows users to download unsigned ActiveX controls from
ActiveX controls
pages. This kind of code is potentially dangerous, especially when
coming from an untrusted zone.
Allow File download

This option controls whether file downloads are permitted from within
the browser.

Allow Scriptlets

This option determines whether web pages can execute or call scriptlets
(JavaScript, Python, Ruby etc.)

Allow Pop-up

Determines whether unwanted pop-up windows appear. Pop-up
windows that are opened when the end user clicks a link are not
blocked.

Allow Font download

This option determines whether users can download HTML fonts from
pages.

Restrictions (Applies to Internet Explorer)
Disable selecting of the
download directory

This option controls whether users are able to change the default
download directory

Disable the ability to view
page source HTML

This option controls whether users can view page HTML source code
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Disable Internet options

This option disables access to Internet options in Internet Explorer

Disable File > Open

Disables File > Open menu item

Disable Save As

Disables Save As menu item

Disable File > New

Disables File > New menu item

Disable Find files command

Disables Edit > Find on this page… menu item

Control Panel (Applies to Internet Explorer)
Prevents changing
Security levels for the
Internet zones

This setting prevents users from changing Security levels on Control
Panel - Internet Options - Security page

Prevents prompt me to
save password from begin

This setting prevents Internet Explorer from showing “Save password”
dialog after user login to a web site

Disable AutoComplete for
forms

Disables IE AutoComplete feature. The AutoComplete feature suggests
possible matches for entries you type in a Web page form.

Disable Internet
connection wizard

Disables Windows New Connection wizard

Settings on Browser Security page apply for both to Internet Explorer and Antamedia Secure Browser.
You can choose from 3 predefined security levels and customize them to your own liking. The number of
features on this page depends on the version of Internet Explorer installed on Kiosk PC.

© 2016 Antamedia

9

Antamedia Kiosk Manual
Browser

2.4

Web Filter
Kiosk software can help you block unwanted URL's or websites from being accessed on your Kiosk. For
this task, we'll configure Web Filter.
In the main Kiosk software screen go to "Browser" and choose "Web Filter" tab. In this tab you can find
more than 2.5 million domains sorted in over 90 categories, such as adult, warez, ads, drugs etc. You
can also create your own list of allowed (whitelist) or blocked (blacklist) domains.
To activate Web Filter please follow these steps:
1. Select the categories you wish to block. Some categories are large (like adult), and performance on
slower computers may depend on the number of included categories and number of domains inside.
2. Optionally define your own whitelist and blacklist, as these categories are checked first for matching
keyword or URL.
3. Click the "Activate" button to turn on "Web Filter" with the selected list of categories and domains.
IMPORTANT
If you want to add or remove some categories or certain domains, please click the "Deactivate" button,
make desired changes and click again the "Activate" button. Your changes will be applied in the "Web
Filter".
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2.5

Search Engine
Kiosk software give you ability to set and configure between different search engines which one will be
used as default when customer click on search button. Configuration is done from Kiosk Browser - Search
Engine page.
Chose your favorite and select to Whitelist search engines.
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Security

3.1

Limited User Account
To achieve maximum security, Antamedia Kiosk creates a limited Windows user account on installation.
When you run the Kiosk for the first time, it will be loaded in Administrator mode, from where you
configure all the features. These settings are stored for the limited account, and loaded on the next
restart.
If you wish to run Kiosk in Windows Administrator account, please select compatibility mode. This option
is suitable if you wish to run HotSpot on the same computer with Kiosk and (Pay Station). HotSpot may
run in the background and control the traffic for WiFi clients around your kiosk. Please contact our staff
for more information on this solution.
It is recommended that any change in settings for Kiosk limited account be made through Kiosk - Security
- User Account page. Here you have the possibility to change account password, description and full
name (displayed on the Windows logon screen). Default account user name (‘Kiosk’) cannot be changed.
If you want to configure Windows to bypass logon screen and login directly to Kiosk account, please check
‘Autologin in Windows using this account’ option.
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3.2

Policies
Kiosk software helps you to configure Windows policies through easy-to-use policy editor. You can select
options to improve or customize system protection in Kiosk protected mode, and to control working
environment of Kiosk limited account. For example, you can allow browsing with Internet Explorer in Kiosk
protected mode, but also to forbid printing of web pages.
To configure policies for Kiosk limited account, please follow these steps:
1.
2.
3.
4.

Open Kiosk - Security - Policies page
Click on policy category to expand it
Select the policies to be applied to Kiosk limited account
Click “Save” button
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3.3

File System
Antamedia Kiosk offers the possibility of blocking access to the selected parts of file system (hard disk
drives).
Please follow these steps to restrict access to a drive volume:
1. From Antamedia Kiosk Security - File System tab.
2. Choose a user account on which will restriction be applied: for Kiosk limited account, for Current user administrator or for all users on this system
3. Select drive letters that you wish to restrict from accessing, and choose one of three types of
restrictions:
- Hide drive will hide selected drive but not forbid the access to a drive
- Restrict access will forbid access but user can see all the drives on the system
- Hide and restrict will hide selected drives and forbid access
Press "Save" button to apply selected option.
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3.4

Folder Access
From Kiosk - Security - Folder Access page you can manage folder access rights for Kiosk limited
account. It is important that you define folder access rights in order to provide maximum security for your
file system. The default settings allow access to the public and Kiosk document folders in order to provide
a way for Kiosk users to view, save and delete files.
Explanations of folder access settings:
Full
Access

Users are granted full access to the folder; they can read, write, execute and delete files
in this folder.

No Access The user account Kiosk will have no access rights at all to this folder.
Read Only Users will only be allowed to view the content of the folder, but will be unable to save or
execute any files.
Read and
Execute

Users will be allowed to view as well as execute files stored in this folder. This kind of
access right is required, for example, to access the folders 'Windows' and 'Program
Files'.

Read and
Write

Users will be allowed to both open and save files. You should definitely assign this kind of
access right to the folder to which you want your users to be able to save files. Users will
then also be able to delete all files previously saved to this folder.
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3.5

Blocked Applications
Blocked Applications feature helps you to disable applications and Windows operations on Kiosk computer
(applications defined in this list are blocked for all Windows accounts on the computer). By default,
Antamedia Kiosk blocks CTRL-ALT-DELETE and prevents starting the Task Manager. Similar to Task
Manager, you can prevent any application from starting.
To define a blocked application, please follow these steps:
1.
2.
3.
4.

Open Kiosk - Security - Blocked Applications page
Enter the program executable in the form programname.exe
Click "Add" button to add this application to the list
Click "Save" button to save changes

Another method for defining blocked applications is based on text which appears in title (top left of the
program). Please choose Windows title from the drop down menu and then type the keyword which
appears in the title.
To enable blocked application again, please select it in the list, uncheck the "Close" checkbox above the
list and click "Modify" button. This way, if needed, you can re-enable the Task Manager or any specified
application. Don't forget to click "Save" when you are finished.
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4

Accounts

4.1

User Accounts and Tickets
User Accounts and Tickets are useful if you want to deploy Kiosk in one of the following scenarios:
Provide access for returning customers, like hotel guests who might use you Kiosk today, and come
back tomorrow until time expires.
Users within your company or organization can use computers in a limited environment with
required authentication for easy tracking. You can limit access to selected hard drives and installed
applications, and allow use of other applications and Windows features. Each Kiosk can have its own
accounts database or multiple Kiosks can be configured to share the same database. Please check
Database section of this manual for details how to connect multiple Kiosks. To create or modify user
accounts or tickets, please open Kiosk - Accounts panel.

Available options are:
Account

Username for the account that will be used for login. It cannot be changed after
account creation.

Password

Account password is hidden by default. Enable Show Password to see account
password. To change client password, replace old password with new one and
press Save Account button

© 2016 Antamedia
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Time Left

Shows remaining time for Kiosk usage. To modify time left, please adjust this
value and press Save Changes button

Unlimited Time

Enable this option if you do not wish to limit selected user by time

Daily time

Total time available for the Kiosk usage on a daily basis. When all daily time is
used, a user can login on the next day

Expire

Specify the date when an account expires. After the expiration date, the account
can not be used anymore for login and a user will see a message that the
account has expired

Printing Pages

Number of allowed color/bw pages that user can print

Unlimited printing Enable this option if you don't want to limit printing for this account

4.2

Active Directory
From Account - Active Directory page you can allow automatic creation of Kiosk accounts by checking
your Active Directory. When the user enters the username and the password, the Kiosk will verify if the
account already exists in the Active Directory, and assign the price plan options and limits. The account
may have an unlimited or a limited time, daily time available and expiration.
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5

Personalize

5.1

Start Menu
Antamedia Kiosk software allows you to create Windows-like Start Menu. Such menu removes all weak
points of the standard menu, and allows you to configure access only to desired programs. To enable and
configure Kiosk Start Menu, please open Kiosk in setup mode and go to Personalize - Start Menu section.
This feature is enabled by default, but you can disable it by unchecking "Show Start Menu button on
taskbar" option.
To add a new item to Kiosk Start Menu, please follow these steps:
1. Select parent folder for a new item (like Programs) or create a new folder using "New Folder" button
2. Open windows explorer and navigate to desired executable file
3. Drag and drop desired file to the white box
4. Click "Save" button
To delete or rename a folder, please select the folder and click on the appropriate button. Additional
Start Menu options are:
Show My Computer button

Identical functionality as in Windows Start Menu

Show Control Panel button

Shows pop-up menu with links to Control Panel applets

Show Turn Off button

Use this button to instantly turn off Kiosk computer

Show Log Off

A customer can log out from Kiosk (not from Windows)

Show Internet Browser button

Internet Browser will be available from Start menu

Show USB button

Use of this option will show USB button
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5.2

Language
Kiosk software supports easy translation to the new languages or modification of the included languages,
like English, German, French, Italian and other. Please note that these translations are available only for
Kiosk protected mode, the setup section is English-only.
To modify the existing translation file, please follow these steps:
1.
2.
3.
4.
5.
5.
6.

Open Kiosk - Personalize - Language page
Choose translation file of the language you want to edit
Click on a line you wish to modify and it will appear in the edit field below
Type a new text
Press Enter key and new line will be stored
Repeat the steps 2-4 for all the sentences you want to translate
When you finish, press Save button

To change Kiosk language, please select language from the drop down menu and click Save.
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5.3

HTML Pages
You can improve the experience for your users by customizing Kiosk pages displayed in Antamedia
Secure Browser. Kiosk allows you to completely redesign or integrate them with existing website. They
can be edited directly with some HTML editor (Dreamweaver, Front Page etc.) or through integrated
editor in Kiosk software. The pages are located in C:\Antamedia\Kiosk\www folder.
To edit pages in Kiosk editor, please follow these steps:
1.
2.
3.
4.
5.

Go to Kiosk - Personalize - Pages screen
Choose the page you want to edit from the drop-down menu
Edit HTML code in the editor window
Click “Save” button
To preview edited page, click “Preview page in browser” button
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5.4

HTML Variables
Kiosk software uses variables to embed links into its web pages. This way, if you change a value of a
single link variable, all pages which use that link will be automatically updated with the new link value.
For example, the “Maps” button on Kiosk start page can be configured to redirect users to Bing or Yahoo
maps instead of Google’s. You can also add your own link variables which can be inserted to Kiosk web
pages.
To configure link variables, please follow these steps:
1. Open Kiosk - Personalize - HTML Variable page
2. Select the value of variable you want to change or click on the last (empty) row in the list to create a
new variable
3. Change variable value or enter a new variable
4. Click “Save” button
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5.5

Terms of Use
To insert usage policy link to Kiosk web pages, please go to Kiosk - Personalize - Terms Of Use page, tick
‘Show Terms Of Use’ option, type or paste policy text in the text area and click Save button.
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5.6

Screen Saver
It is possible to activate Screen Saver to protect your desktop when there is no activity on Kiosk
computer.
Go to Kiosk Personalize - Screen Saver page and set will you activate some of available screen savers on
computer or to use Digital Signage.
When you finish with setup press on Save button.
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5.7

Desktop
If you would like to use specific desktop background for your Kiosk limited Windows account, set it from
the Kiosk Personalize - Desktop page.
Press on Load Desktop Image button and choose *.bmp image from hard disk. Picture position can be set
to fill, fit, stretch, tile or center if it is required.
Press on Save button to store changes.
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6

Digital Signage
Antamedia Kiosk software allows you to transform it into digital multimedia display using Digital Signage
feature. Digital Signage makes possible to deliver a custom-tailored mix of informational and advertising
content, including product promotions, timely news, and upcoming events. You can configure your
message by combining videos, images, web pages and flash animations.
To set up Digital Signage, please follow these steps:
1. Open Kiosk - Digital Signage page
2. Press on Add button
3. Choose the file, folder or web page
4. Select number of seconds for how long it will be visible (default is 20 seconds)
5. When you finish with adding content for Digital Signage go to main Kiosk screen, select Digital Signage
and click "Save" button
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7

Setup

7.1

Options
Kiosk Setup password is a password that unlocks your Kiosk from the protected mode. It should be
entered when operator wants to switch between Kiosk protected and setup mode using CTRL + ALT +
SHIFT + K key combination. Unlock Key Combination can be changed. Password can be changed from
Kiosk - Personalize - Start Menu or Kiosk - Setup - Options screen.
IMPORTANT! This password works only in licensed version. If Kiosk software is not licensed, any
password can be used to unlock Kiosk Setup mode.
From this page you can setup SMTP settings for Kiosk emailing. Antamedia Kiosk software has integrated
email form, which allows Kiosk users to send emails directly from Antamedia secure browser. This form
by default uses Antamedia SMTP server to send emails; however, you should configure it to use your
SMTP server.
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7.2

Online Reports
Online Reports will help you remotely monitor your computers and get reports and statistics. Kiosk
automatically collects usage data (session, Kiosk usage, application etc) and sends it to the Online Report
portal. To check usage data for each registered Kiosk, please go to http://www.antamediaonline.com and
enter your Username and Password. Online Reports also gives you ability to control remotely all
registered Kiosks (send specific command, restart Kiosk, shutdown Kiosk, end client session, send file
to a specific location etc.)
To use Online Reporting with Antamedia Kiosk software, start Antamedia Kiosk and go to Setup - Online
Reporting page. If you are configuring Online Reporting for the first time, you have to press "Sign Up - for
a test account" button. If you already purchased subscription and received Registration Code, please
press "Login - with existing user" button.

When you press the "Sign Up" button you have to fill out the form (Email and Password are mandatory)
and press "Create User Account" button. This will start the registration process which will provide you
Registration Code (RegCode) that you can use to register all the computers in the Online portal. In the
next step, please choose "Location" name for that computer and press the "Connect" button. To start
logging actions in the Kiosk software, please enable "Auto connect this Kiosk to the Online Reports". Kiosk
will start sending periodically logs to the Online Reports portal (http://www.antamediaonline.com), and
you can login to see the data and filter reports.
Online Report portal is available as a subscription service and as licensed software that can be installed
on your Windows-based server. In this case, there is the only license fee, without ongoing subscription
fees. Please contact us for more details at sales@antamedia.com
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7.3

Prepare Files
This feature helps you to prepare (zip) files for sending to other kiosks, it is located on Kiosk - Setup Prepare files page. The main purpose of this feature is to allow sending configuration files, updates,
content and images to all kiosks connected to Antamedia Online Portal (www.antamediaonline.com).
Kiosk configuration files are usually located in C:\Antamedia\Kiosk\Data and XML folders.
To send files to other kiosk, please follow these steps:
1. Select the desired files in the explorer window and drag them to the box on the right side of the
screen, limit for one package is 3MB
2. Click "Compress and Save ZIP file" button, select location on hard disk and click "Save"
3. Login to your AntamediaOnline account
4. Select "Send file to location" option
5. Choose to which kiosk locations file will be sent
6. Select the file for upload and click "Send" button
7. If you sent configuration files to kiosk(s), please restart kiosk program with "Software restart"
command from "Application commands" menu
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7.4

HTTP Server
Kiosk software displays pages in the Secure Browser using the built-in HTTP server. By default, Kiosk
uses port 880, but it can be changed if some other application is using it.
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7.5

Database
Antamedia Database Server stores the data from Kiosk software (customers accounts, tickets, pricing
plans, bills etc.). Database Server will be installed from Kiosk Installer.
Kiosk can use database on a local computer, or it can be connected to remote Database Server. This may
help if you run multiple kiosks that should share user accounts. Kiosk is configured to use a local database
by default.
If you intend to run multiple Kiosks and share the accounts between these locations, you will have to
install Database Server on a computer with Public IP address (accessible from Internet) and configure all
Kiosks to use that database. To connect Kiosk to remote Database Server, please go to Kiosk - Setup Database page and enter remote server IP in DBServer IP Address field and click Save button. Ensure
that TCP port 12010 is opened on both Kiosk and Database Server computers.
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7.6

Pay Station
Kiosk Premium and Enterprise editions have Pay Station module included, which helps you receive
payments via coin and bill acceptors hardware devices using CCTalk protocol (supported by major
hardware manufacturers). Pay Station also accepts payments by Credit Cards through the one of 70
supported Internet Payment Gateways. Complete list of the supported payment gateways is available at
http://www.antamedia.com/accept-credit-cards
From Kiosk - Setup - Pay Station page you can enable Pay Station module, configure settings for it and
set simple pre hour pricing method and press on Open Pay Station Setup button for advanced setup and
configuration.
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7.7

Watchdog
The main purpose of Watchdog service is monitoring Kiosk operation and controlling if a problem occurs
(browser or Flash plug-in crashing, Windows hanging, hacking attempts etc.). Watchdog is installed
automatically during Kiosk installation and it will auto-start on Windows start-up. Kiosk is constantly
sending pings to Watchdog during proper operation, if there is interruption which lasts longer than
predefined time period, Watchdog has the ability to restart Kiosk application. Default behavior is taking no
actions.
To configure Watchdog behavior, please go to Kiosk - Setup - Watchdog page and uncheck “No Actions”
option. The following options will be revealed:
Restart Kiosk if no ping after Use this option to force Kiosk restart if it is not sending pings to
Watchdog longer than specified time period
Restart Kiosk always in

Configure this option to force Kiosk restart at desired time of the
day. Use the “Except” option to specify date range when this rule will
not be used.

Restart Kiosk if no login user Watchdog will force Kiosk restart if no one logins in specified time
for
period. Use the “Except” option to specify a time of the day when
this rule will not be used.
Minimal Interval between
controlled restarts is
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7.8

Print Manager
Antamedia Kiosk software give you ability to control and limit printing over your Kiosk computer.
From Setup - Print Manager page activate option Use Print Manager and set prices for black & white and
color print per page.
Save changes to restart computer to activate it.
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7.9

Memory Monitor
It doesn't happen often, but in some cases computer memory usage can be over desired values. Simple
restart will refresh kiosk and give better performance to your end users. Activate Use Memory Monitor
option from Kiosk Setup - Memory Monitor page and set memory usage limit.
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7.10 USB Manager
USB monitor is utility that prevents various storage devices from connecting to your computer via USB
ports. From Kiosk - Setup - USB Manager page you can activate option Use USB manager for USB
storage devices.
Use USB storage device to unlock Kiosk will allow you to Create USB key that you will use in future for
unlocking Kiosk software.
Show USB devices arrival in protected mode option require to set list of allowed file extensions that your
customers will be able to load from it.
Save changes and restart Kiosk to apply changes.
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8

Licensing
Your lifetime license and the download will be available after your purchase. You will receive an email
from Antamedia Sales with instructions how to activate the software. Licenses are sent out automatically
upon successful customer identification.
Your order can be placed in several ways:
- Online through our website www.antamedia.com and we'll immediately send you instructions how to
activate the software. License is automatically delivered within a minute after completing activation steps.
- Wire transfer from your bank to our bank account. Please contact us for details.
- Purchase order. Please contact us for details.
If you already installed Antamedia software, you will not have to change any configuration. All your
settings will be saved and the trial limits removed, so you can enjoy all features without restrictions.

© 2016 Antamedia

37

ANTAMEDIA
NEBOJSINA 30
11000 BELGRADE
SERBIA
Back Cover

SALES
US +14088444480
UK +442081446610
INT +381652106600
INT +381652108800
sales@antamedia.com
CUSTOMER SUPPORT
US +14088444450
AU +61280035990
INT +381652107700
INT +381642101636
support@antamedia.com

www.antamedia.com

